AutoCAD Module 1A: 1A- 1

The Basic Concepts and Application of Descriptive Geometry

Part One
INTRODUCTION

Module 1A
The Basic Concepts & Application of
Descriptive Geometry

Section 1
Basic Concepts of Descriptive Geometry

Descriptive geometry is the science of graphical representation and solution of
spatial relationships of points, lines, and planes by means of projections, it makes
analysis of spatial relationship (“geometry,” or “location measurement”) of the three
basic geometric elements (points, lines, and planes) in any three-dimensional objects
(called "solids™). Engineers and designers use the knowledge of descriptive geometry to
project three-dimensional figures onto a two-dimensional plane of paper in such a way
that allows the determination of lengths, angles, shapes and other information.

Please use the following props, and refer to the drawings on the next page to
try out the concepts of descriptive geometry:

e Two pencils (representing lines);
e Three candies (representing points); and

e Two pieces of cardboard (representing planes);

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



AutoCAD Module 1A:

The Basic Concepts and Application of Descriptive Geometry

1 Point

+

2 Points establish 1 line

Figure 1-1A: Point and line
(left); AutoCAD Point Styles
dialog window (right).
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Figure 1-1C: Two parallel
straight lines (top) and two
intersecting lines (bottom) on
the same plane.
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Figure 1-1B: Two
intersecting lines sharing
one common point.

Figure 1-1D (Bottom): Two skew lines on different planes,
appearing “parallel” in one view (bottom left); and two
parallel lines on the same plane, appearing in at least two

principal views (bottom right).
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Basic concepts used in descriptive geometry:

Points, lines, planes (surfaces) and solids

e Point: A point is a location in space with no dimensions other than its spatial
location. Two points establish a line or line segment; a point has location
coordinates but no dimensions; a line has length as its dimension; in
traditional drafting practice, a point is usually represented by a + or X
symbol; in AutoCAD, points are created with the Point tool and many styled
symbols can be used by going to the Format->Point Style menu (Figure 11-
1A).

e Intersecting lines: Two line segments having one point in common are
intersecting lines. Example: line 1-2 (a line that is defined both two endpoints,
point 1 and point 2) and line 2-3 (a line that is defined both two endpoints,
point 2 and point 3) are intersecting lines, which share the point 2 as the point
in common; notice that points 1, 2, and 3 can have any sets of x, y, z-
coordinates in three-dimensional space (Figure 1-1B).

e Lines on the same plane: Two straight lines on the same plane must intersect
unless the lines are parallel (Figure 1-1C).

e Skew lines: Nonintersecting and nonparallel lines are called skew lines; notice
that two lines may appear to be parallel in a particular view, but as long as
they do not lie on the same plane, they are actually skew lines (Figure 1-1D).

e Plane: A plane is a “flat” 2D geometric entity defined by three points, or by
one line (which is defined by two points) plus one point, anywhere in the
three-dimensional space (Figure 1-1E); theoretically, a plane can be
considered as extending to infinity in all directions without borders.

e Surface: A surface is a 2D geometric entity with a finite area but without
thickness or volume, and it can be represented by: (a). intersecting lines; (b).
parallel lines; (c). three points not in a straight line; (d). a line and a point not
on the line; a surface is the tangible part of an object; it can be flat, curved
(single-curved or double-curved) or warped (Figure 1-1F).
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Figure 1-1E: A plane defined by three points.

Warped Surface Flat Surface
Single Curved
Surface
Double Curved

Surface

Figure 1-1F: Flat surface, single- and double-curved surfaces, and warped surface.

e Piercing Points: if a straight line is not parallel to a plane, it must intersect
that plane in a single point called a piercing point (Figure 1-1G).
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Figure 1-1G: A piercing point.

Ruled Surface: A ruled surface is any surface generated by a moving straight

Piercing Point

line, and can be a plane, a single-curved surface, or a warped surface. A plane
can be created by moving a straight line (the “generatrix”) along a straight line
path (called the “directrix”). A non-planar, curved or warped surface can be
created by moving a straight line or curved line “generatrix” in the three-
dimensional space along a path that is not straight. The straight line that
generates the ruled surface is called the generatrix; and any position of the
generatrix on the surface that is created by the motion of the straight line
“generatrix” is called an element. In AutoCAD, a ruled surface can be created,
for example, by first using 2D drawing tools (such as Line and Arc) from the
Draw tool bar to create two lines, straight or curved, on different planes
created with various options of the UCS tool; and then by using the Ruled
Surface tool from the Surface tool bar (Figure 1-1H).

The intersection of two planes: It is a straight line with all points common to
two planes (Figure 1-1J).

Intersection Planes 1 and 2

) v

Figure 1-1J: Intersection of two planes (a
straight line).
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Figure 1-1H: Ruled surfaces. Creating two different planes
Generatrix  with the Move option of the UCS tool; and using the Arc tool
from the Draw tool bar to create two Arc elements on
different planes (top left).

A

Using the Ruled Surface tool from the Surface tool bar to
create a ruled surface by picking the two Arc elements on the
same sides; and by on the opposite sides (middle).

The generatrix and elements on a ruled surface (bottom left).

Elements
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Solid: A solid can be defined by four points in the three-dimensional space;
among these four points, three points defined a plane, and the fourth point
does not lie on the plane defined by the other three points. Solids are bounded
by surfaces (flat, curved or warped); and in practice, the term solid refers to
any 3D closed form, which may be either solid or hollow (Figure 1-1K).

the 4th point not on the plane

3 points define 1 plane

Figure 1-1K: A solid defined by four points, and bounded by flat surfaces.

Parallelism, perpendicularity and angularity

Parallelism: In any view, parallel lines in space will be projected as parallel
lines, or as points when they are perpendicular to the viewing plane, or
coincide as a single line when they are parallel to the viewing plane and lined
up one behind the other. Parallel planes: If a pair of intersecting lines in one
plane is parallel to a pair of intersecting lines in a second plane, then the
planes are parallel. Line parallel to plane: A line is parallel to a plane if it is
parallel to a line in the plane; a plane is parallel to a line if it contains a line
that is parallel to the given line (Figure 1-1L).

Perpendicularity: A 90° angle appears in true size in any view showing one
leg true length, provided that the other leg does not appear as a point in the
same view. A Line perpendicular to a plane: A line perpendicular to a plane
is perpendicular to all lines in the plane. For a simpler statement, we can say
that: A line perpendicular to a plane is perpendicular to at least two
nonparallel lines in the plane. This line will also appear perpendicular and in
true length to the edge view of the plane. Perpendicular planes: If a line is
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perpendicular to a given plane, any plane containing that line is perpendicular
to the given plane (Figure 1-1M).

e Inclined line: Aninclined line is also called an angled line; and it appears
true length on the plane to which it is parallel. Inclined lines are often
classified as frontal (corresponding to front view), horizontal (corresponding
to top view) or profile (corresponding to side view), see Figure 1-1N.

Parallel Lines Line

/
\ \/ |

/ I._“
Parallel Planes
Perpendicularity
Figure 1-1L (left): Parallel Maia
planes and parallel lines.

Figure 1-1M (right): A Line
perpendicular to a plane (top),
and two perpendicular planes 2 Perpendicular Planes

(bottom).
7

Top View
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. Congruent Surfaces
Top View = ‘

(Foreshortened)

Auxiliary View
(True-Shape, TS)

Figure 1-1R: Congruent
surfaces.

Front View Right View A surface on an inclined plane
(Edge View, EV) (Foreshortened)

Figure 1-1Q: True-shape view of a surface.

Direction of sight, true-length, true-shape and congruity

e True-length: The true-length (abbreviated as TL) view of an inclined line is
always in an inclined position, and the foreshortened views are always in
either vertical or horizontal positions (Figure 1-1P).

e True-shape: The true-shape view of a surface is always on the view where
the surface is perpendicular to the line of sight (Figure 1-1Q).

e Congruence: Congruence or congruity: two neighboring faces with similar
shapes are congruent or congruous (Figure 1-1R).

e Line of sight and views: If a direction of sight (also called line of sight and
abbreviated as LOS) is parallel to a true-length view of a line, then that line
will appear as a point (point view or PV) in the resulting view. If a direction
of sight is perpendicular to a true-length (TL) view of a line, then that line will
appear as a true-length line in the resulting view. If a direction of sight is
neither parallel nor perpendicular to a true-length view of a line, then that line
will appear as a foreshortened line in the resulting view (Figure 1-1S).
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Figure 1-1T: Intersection of two solids.

Figure 1-1U: Folded model (left) and
development (right).

Intersection and development

e Intersection: An “intersection” is a point or a line that is formed when two (or
more) geometric forms (such as two planes or a prism and a cylinder) meet or
pass through each other (Figure 1-1T).
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e Development: The term “development” in engineering descriptive geometry
refers to an unfolded (or “developed”), flat surface (also called “surface
development,” “stretch-out,” “flat pattern” or “templates”) of a three-
dimensional object, and can be either a precise development (for any “single-
curved” object) or approximate development (for any “double-curved” object,
such as warped surfaces and sphere (Figure 1-1U).

Graphical mathematics

e Dihedral angle: The angle between two adjacent flat surfaces on a three-
dimensional solid or two planes in space. In AutoCAD, using the Angular
Dimension tool to measure the dihedral angle on a 3D solid is a complicated
process; therefore, in the subsequent learning modules, the focus will be
placed on using two-dimensional orthographic projection methods to obtain
the dihedral angle. In Inventor, it can be accomplished easily with the
Measure Angle tool (Figure 1-1V).
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Figure 1-1V: The dihedral angle between two planes in

space (left) and between two adjacent flat surfaces on a
3D solid model (middle). Inventor Measure Angle tool

(right).
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Parallelogram

Component Force
Vector 2

r . N
Resultant Force Vector

R

Figure 1-1X: Vector force analysis.

\

\ Component Force
Vector 1

e Shortest distance: For two non-intersecting lines in the three-dimensional
space, the distance defined by the shortest possible line that can be draw
perpendicular to both non-intersecting lines (Figure 1-1W).

e Vector force: The method of obtaining the resultant force of two or more
component forces by drawing a parallelogram using the component force
vectors as sides and by drawing the diagonal line as the resultant force vector
(Figure 1-1X).

Section 2
Types of Surfaces and Solids

The motion of a straight or curved line creates a geometric surface. Geometric
surfaces can be used to define volumes of solids.

In practice, the term solid refers to any 3D closed form, which may be either solid
or hollow. There are basically three types of solids:

1. Polyhedrons

Polyhedrons are solids bounded by plane surfaces called “faces” with lines of
intersection of faces called “edges.” Plane (flat) surfaces are found on all faces of
polyhedrons, such as cube, prism, tetrahedron, pyramid, as well as on the top and/or
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bottom faces of cone and cylinder. They can be precisely developed. The following Five
Regular or “Plutonic Solids” have plane surfaces only:

e Tetrahedron: with four equilateral triangular faces (Figure 1-2A).

e Hexahedron (cube): with six square faces (Figure 1-2B).
e Octahedron: with eight equilateral triangular faces (Figure 1-2C).

e Dodecahedron: with twelve pentagonal faces (Figure 1-2D).

¢ Icosahedron: with twenty equilateral triangular faces (Figure 1-2E).

")

%

Figure 1-2A: Tetrahedron. Figure 1-2B: Hexahedron (cube).

&N O

Figure 1-2C: Octahedron. Figure 1-2D: Dodecahedron.

P

Figure 1-2E: Icosahedron. Figure 1-2F: Prism (left) and cylinder (right).
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2.

Solids of revolution:

They are generated by revolving a plane figure about an axis in the plane of the
figure. They include:

Single-curved surfaces: They are found on the lateral surfaces of cone and
cylinder. They are ruled surfaces and can be precisely developed. Two types
of relationship between the generatrix and the directrix may exist on a single-
curved surface: (1) Cylinder or prism (Figure 1-2F): a single-curved surface
can be generated by a straight line generatrix one point of which moves along
a plane-curve directrix, and the generatrix always remain parallel to its
original position as for a cylinder; for example, in a cylinder, all elements of a
cylinder are parallel to each other and to the axis of the cylinder. A plane
tangent to a cylinder contains only one straight-line element of its surface, and
is parallel to the remaining elements and to the axis); or (2) Cone and
pyramide (Figure 1-2G): a single-curved surface can be generated by a
straight line generatrix one point of which moves along a plane-curve directrix,
and the generatrix keeps passing through a fixed point (the vertex) as for a
cone. In a cone, all elements of a cone pass through its vertex. A plane tangent
to a cone contains only one straight-line element to its surface, and this
straight-line must pass through the vertex of the cone. Right-circular cones:
All elements of a right-circular cone form the same angle with the base plane
of the cone. A plane tangent to a right-circular cone contains one element and
forms the same angle as does any element with the base plane of the cone. If
two right-circular cones with the same vertex and elements of the same length
intersect, the common element or elements of the two cones form the same
angles with the two base planes as do the respective sets of elements.

Figure 1-2G: Coné and pyramid_ Figure 1-2H: E”IpSOId, torus, and sphere.

Double-curved surfaces: They are found on the surfaces of sphere, oblate
spheroids or ellipsoids, paraboloids, torus, etc. They can be approximately
developed only. They can be created by revolving a curved line about a
straight line. Sphere is a typical example of a solid bound by a double-curved
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surface, which contains no straight-line elements but only infinite number of
points equidistant from the center of the sphere. A plane tangent to a sphere
contains one and only one point in that surface. Double-curved surfaces can
be developed only approximately by dividing them into sections and
substituting for each section a developable, plane or single-curved surface
(Figure 1-2H).

3. Solids bounded by warped surfaces

Warped surface: They include automobile hood and others, and cannot be
developed by regular method; however, approximate development of a warped surface
can be made by dividing the usually smooth warped surface into sections and substituting
for each section a developable, plane or single-curved surface such as with a series of
triangles. A warped surface is a non-developable ruled surface generated by straight lines
moving in various patterns. In a warped surface, no two adjacent positions of the
generatrix lie in the same plane. Warped surfaces include conoid helicoids, hyperboloid,
streamlined surfaces of aircrafts and automobiles. Screw threads are examples of solids
bound by warped surfaces (Figure 1-3). In practical fabrication, objects with warped
surfaces are made by stretching, pressing, stamping, spinning, or vacuum or explosive
processes, which are applied to flat sheet materials if they are pliable enough.

Coil : Tapered Coil

]| [+s000m ]

Revolution Taper
[cooa ] [5o0des 3]
o) _ x| o |

Figure 1-3: Screw threads in
the form of helicoids (left).
Tapered helicoids modeled in
Inventor (right).
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We have explored so far various concepts and terminologies used in descriptive
geometry, with text and figure illustrations. To better understand these concepts and
terminologies before proceeding to hands-on learning of the subjects with AutoCAD 2D
tools, we can open the relevant digital files inside the Descriptive Geometry Concepts
Ilustration folder of the enclosed Student Descriptive Geometry Learning Resource CD
(Figure 1-4A). The files have been created in either AutoCAD or Inventor. The
AutoCAD files have been saves in AutoCAD 2000/LT 2000 Drawing [*.dwg] format;
and be opened with any version of AutoCAD 2000/LT 2000 or later. The Inventor files
are created in Inventor 10 version. It might be more convenient to launch the AutoCAD
and Inventor programs first and to open the files from the programs’ File->Open menu,
rather than double-click the files’ icon to open them.

& Descriptive Geometry Concepts Illustration E@@
Iy
N

File Edit Wiew Favorites Tools  Help

Q Back ~ g ir /"- ) Search Folders Elv

fddress | C\Documents and Settings\Edward Locke\Deskbop!Stod a G0

[T il If[] Piercing Poink

[l Congruent Surfaces Ruled Surfaces,dwg

[Tl Helicoidal Screw Threads Ij Skewed Lines

[Tl Inclined Line Salid Defined by 4 Painks, dwg

[ Intersection of 2 Solids |j| Solids

[l Intersection of Two Planes @ Surfaces

[l Parallel and Intersecting Lines |j| True Shape

[Tl Parallel Lines Twi Intersecting Lines & & Plane,dwg
[T Parallel Lines & Planes Wector Force Analysis,dwg

[Tl Ferpendicular Flanes and Line

£ *

Figure 1-4: The digital files.

Tools that help to move the models in these files are explained in Figure 1-4B (for
AutoCAD) and Figure 1-4C (for Inventor).

e In AutoCAD, various options in the View->3D Views menu can help to view
the model from different view perspectives. The 3D Orbit tool (from the 3D
Orbit tool bar) can be used to rotate the model; to use this tool, drag on the
handles at the four quadrants of the “circle” to rotate around X or Y axes; drag
inside the “circle” to freely rotate the model in 3D space; and drag outside the
“circle” to rotate circularly on the XY plane.
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Figure 1-4B: AutoCAD tools. The View 23D Views menu for viewing the model from different view
perspectives (left). The 3D Orbit tool for rotating the model (right).

¢ In Inventor, the View—>Isometric menu helps to view the model in isometric
view. The Rotate tool (from the Inventor Standard tool bar) helps to rotate
the model; this tool contains both Free Rotate [SPACE] (with a “circle”
symbol) and Common View [SPACE] options (with a “cube” symbol),
which can be changed by right-clicking for the shortcut menu and choosing
the appropriate option; to use the Free Rotate [SPACE] option of this tool,
drag on the handles at the four quadrants of the “circle” to rotate around X, Y
or Z axes; drag inside the “circle” to freely rotate the model in 3D space; and
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drag outside the “circle” to rotate circularly on the XY plane (right); to use the
Common View [SPACE] option of this tool, click on an arrow at any corner
of the “cube” to rotate the model to an isometric view; click on an arrow at
any edge of the “cube” to rotate the model to an orthographic view. To use the
Look At tool (from the Inventor Standard tool bar) to rotate the any flat
surface of a model or any Work Plane feature to the normal view (which is
perpendicular to the lone of sight or LOS), click select the tool’s icon and the
surface or Work Plane (the order of selection does not matter).
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Figure 1-4C: Inventor tools. The View ->Isometric menu for viewing the model in isometric view (left). The
Rotate and Look AT tools for rotating the model in 3D space (top right). The shortcut menu for choosing
the Common View option (middle right). The “cube’ symbol for the Common View option (bottom)
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Section 3

The Application of Descriptive Geometry in Sheet Metal Trade with
Intersection and Development

Application of intersection and development in sheet metal products

The knowledge and skills related to intersection and development of solids can be
applied to the following trades:

Aerospace, ship construction and automobile industries: The knowledge of
intersection and development is used to determine various shapes of
instrument panels, window opening, and body sections (such as the skin of an
aircraft).

Architectural design: The intersection of surfaces is needed for the design and
specification of building fixtures (such as a pipe that goes through a wall).

HVAC (heating, ventilation, air conditional and cooling): Sheet metal
products, used primarily in ductwork all use the knowledge of intersection and
development. The design and construction of boilers, smokestack breeching,
storage tanks, office furniture, cabinets, and of refineries in the oil and
chemical industries need the knowledge of intersections.

Packaging: The knowledge of intersection and development of patterns can be
used in the design of containers (electrical equipment housing, computer case,
milk carton, cardboard cereal box, and other packaging products).

The Process of Design and Fabrication of Sheet Metal Products

There are basically there steps in the process of design and fabrication of sheet
metal products:

1.

Pattern development: The engineer or designer first draws a development
pattern together with a pictorial drawing (usually isometric) of the finished
product. Development pattern can be either an inside or an outside pattern.
An inside pattern shows the inside surfaces of the object, and is traditionally
the preferred method because the fold lines marked on the surface will not be
seen when the object is folded, and because the folding equipments are
usually designed to bend the patterns inward. An outside pattern shows the
outside surfaces. Traditionally, designers indicate on the drawing whether the
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pattern is inside or outside so as to avoid any chance of misunderstanding. A
pattern development should include cutting line (lines along which the flat
pattern should be cut) and fold line (lines that show the location where the
development is to be folded). Fold line can be indicated by a x mark across
them (Figure 1-5A).

Cut line

Seam

LATERAL "
SURFACE N

b ¢ d %
H /!\\ > AN Pas ‘
\ /

Fold line and X mark BASE

"SEAM LINE >\

Figure 1-5A:Cut line, fold line with x mark, and seam.

2. Pattern cutting: The pattern is cut from flat sheet of material, such as sheet
metal (tin, steel, copper, brass, aluminum, etc), paper, cardboard, corrugated
boards, plastics, films, wood, fiberboard, fabrics.

3. Shape-forming and assembling: The cut pattern is folded or rolled into desired
3D shapes and fastened (or glued, or welded) together with specially designed
machines.

Students who want to learn more about sheet metal fabrication may check out
related books (such as those listed in Section 2.2.2.1 Textbooks on sheet-metal trade of
Chapter 2 Review of The Literature of this textbook project, in local technical libraries;
or refer to the following technical books (available at technical bookstore such as
OPAMP Technical Books (1033 N. Sycamore Ave., West Hollywood, California;
telephone number: 323-464-4322):

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



AutoCAD Module 1A: 1A-21

The Basic Concepts and Application of Descriptive Geometry

e Techniques of Pressworking Sheet Metal An Engineering Approach To Die
Design 2nd Edition: published by Prentice Hall, ISBN 0-13-90096-6.

e Sheet Metal: written by Leo A. Meyer, published by American Technical
Publishers Inc., Homewood, Illinois 60430, ISBN 0-8269-1907-3.

e Mechanics of Sheet Metal Forming: written by Z. Marciniak, J. L. Duncan, S.
J. Hu, published by Butterworth-Heinemann, An Imprint of Elseview Science,
Linacre House, Jordan Hill, Oxford OX2 8DP, 225 Wildwood Avenue,
Woburn, MA 01801-2041, www.bh.com; ISBN 0-7506-5300-0,.

Important principle to remember:

For effective design and fabrications of sheet metal products, which shall save
labor and cost in fabrication and make the products more functional, the following
principles are helpful:

1. Feasibility: In the drafting of surface development, each plane must be drawn in
a correct position next to another plane, or to make it simple, two adjacent
planes on the 3D objects need to be drawn on the surface pattern in such a way
that when folded up, they will be adjacent again.

2. Cost effectiveness: In order to reduce the amount of work needed in welding, in
applying adhesives, or in using rivets, patterns should be developed in such a
way that the ends to be joined are the shortest possible. The drafter also needs to
take the stock sizes into consideration so as to save materials and labor.

3. Aesthetics: As much as possible, the patterns should be developed in such as
way that on the finished products, the joints are in the most invisible places.
A good way to check for errors in the drafting of development:

Cut a scaled-down paper pattern and secure the joints with tape to see if the
development works!

Some real world design parameters

In this collection of learning modules for the solution of descriptive geometry
problems using the 2D tools of AutoCAD, the focus of our study is on the application of
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orthographic projection methods. In the real world of design and fabrication, however,
some technical parameters are taken into consideration, although they shall not be a part
of our study in the Modules. These technical parameters include but are not limited to the
following:

e Bend allowances: In the real world application of development, bend
allowances or thickness allowance: calculation for bending and stretching for
sheet metals, as well as thickness allowance for paper materials, are needed
depending on the material used. However, this collection of Modules is
primarily concerned with the 2D orthographic projection methods related to
intersection and development of patterns, technical parameters such as bend
allowances and thickness allowance will be ignored in most of the Modules.
Parametric CAD programs such as Autodesk Inventor (which is explored in
this textbook project), CATIA, SolidEdge, SolidWorks, Pro-Engineer, etc.,
can generate flat patterns from the 3D folded part with calculation for these
parameters built in.

e Seams and laps: Extra material called “seams and laps” is added to the cut
edge of pattern (the shortest edge is preferred) for the fabrication of the 3D
folded parts. Throughout this collection of Modules, students are encouraged
to use heavy card stock paper (110 Ib) to build models of their projects.

e Wiring: A way of strengthening open ends of sheet metal material by
enclosing a wire in the edge; a band of material with a width equal to 2.5
times the diameter of the wire is added to the pattern. This parameter shall be
ignored in most of the Modules.

e Hemming: a way of stiffening the edges sheet-metal parts with bended and
interlocked extra material on both end edges; its includes single and double-
hemming (Figure 1-5B). This parameter shall be ignored in most of the
Modules.

e Seaming: similar to hemming and includes soldering on lap seams, flat lock
seams, grooved seams and other types of seams (Figure 1-5C). This parameter
shall be ignored in most of the Modules.
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Shape | Unfold Options | Relief ptions |
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@ Anply |#I Cancel |_]
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Figure 1-5B: Various types of hems (3D models created in Autodesk Inventor).

Figure 1-5C: Locking seam (left).
Dovetail seams (right).

The creation of packages needs both engineering and artistic skills because
packages need to protect the goods and also look attractive for sales appeal. Some
packages are used for a long time while others are used briefly and recycled. Packages
need to be designed in such a way that they can be mass-produced easily and at a
reasonable cost. Almost all packages are printed. Most packages need glue on their tabs
while others are designed in a way that no glue is needed.
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Various types of development
Developments can be classified under the following three categories:

o Parallel line development: used for objects having parallel elements, such as
prisms and cylinders.

o Radial line development: used for objects having elements “radiating” from a
vertex point, such as pyramids and cones.

e Triangulation development: used for transition pieces by breaking a surface
that can not be developed by the methods of Parallel line development and
Radial line development, into a series of triangles.

Details of the above three methods will be covered in the subsequent Modules.
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Figure 1-5D: Launching AutoCAD 2006 from the Start menu.
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Figure 1-5E: Selecting either Imperial [feet and inches] or
Metric, and clicking the OK button to start a new file.

Section 4
Getting Ready To Solve Descriptive Geometry Problems
in AutoCAD 2D Environment

Foundation in AutoCAD for use of this collection of learning modules

This collection of descriptive geometry learning modules using the 2D tools of
AutoCAD program has been written in such a way that each individual tool with its
particular options ad settings, as well as each step in the completion of any particular
project are thoroughly described in great details. Therefore, there is practically little need
for students to possess great skills in AutoCAD in order to use the learning modules
contained in this collection. However, a beginning course in AutoCAD (covering basic
settings and 2D tools) is helpful. For those students who has never taken any course in
AutoCAD before, any of the following is recommended:

e Concurrently enroll in a beginning AutoCAD course.
e Running through the Lessons in either of these two textbooks: 1. AutoCAD

2006 Tutorial First Level: 2D Fundamentals written by Randy H. Shih and
published by Schroff Development Corporation (www.schroff.com); 2.
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AutoCAD 2006 Exercise Workbook for Beginning AutoCAD written by Cheryl
R. Shrock, Chair of Drafting Technology at Orange Coast College, Costa
Mesa, CA, and published by Shrock Publishing (714-557-2555).
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Figure 1-5G: The AutoCAD 2006 Help window with its bar docked on the Start menu bar at the
bottom of the screen.

AutoCAD on-line User’s Guide and Search for topics

AutoCAD 2006 program contains an on-line User’s Guide that provides a wealth
of information on all tools and settings. To access the on-line User’s Guide, first launch
the AutoCAD program (Figure 1-5D); next, in the Startup dialog window, click-select
the bullet button on the left of either Imperial [feet and inches] or Metric text, and click
the OK button to start a new file (Figure 1-5E), a new file opens; next, click-open the
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Help pull-down menu (the rightmost on the menu bar), and choose the Help option
(Figure 1-5F), or press the F1 key on the keyboard to select the same menu, the
AutoCAD 2006 Help window opens with its bar docked on the Start menu bar at the
bottom of the screen (Figure 1-5G), if the AutoCAD 2006 Help window is hidden, then
click bar to bring the window to the front. The AutoCAD 2006 Help window has two
main panels; the left panel has several tabs; the User’s Guide is under the Contents tab;
the User’s Guide is organized by topics; and to access the topics, click-open the boxed +
sign on the left of the related topic listing. The Search tab allow user to type the text on
requested information and obtain a list of related topics; to use this tool, click-open the
Search tab, type a text string for requested information and click the List Topics button,
a list of related topics appears in the left panel; click-select a listing, double-click on it or
click the Display button, the information appears immediately on the right panel (See
Figure 1-5H).
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Figure 1-5H: The Search engine for AutoCAD program information.
The most important tools and settings used in the learning modules

The most frequently used tools in this collection of learning modules are listed in
Figure 1-5J. There are three basic methods for accessing a tool (Figure 1-5K):

e Pull-down Menu: Tools are grouped under various pull-down menus; some
options of a particular tool (such as Arc) can be accessed only through the
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pull-down menu. However, it is usually more time-consuming to access a tool
this way; therefore, this method is generally not recommended.
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Figure 1-5J: The most frequently used tools in this collection of learning modules.

e Tool Icon: Tools can be accessed by clicking a tool icon on a related tool bar;
however, in most cases, tool icons do not provide access to the options of the
tools (in AutoCAD, options of tools are selected by typing the capitalized
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letter of the name of the option listed in the Command Line and then pressing

the Enter key on the keyboard); therefore, this method is not recommended

either.

Commend Line: AutoCAD started as a code-based program and still carries
this tradition, although it has evolved over time into a program based on GUI
(graphical user interface); most of the tools and settings in AutoCAD can be
invoked by typing the full name or the code (usually the first letter, or a few
letters from the names of the tools), and then pressing the Enter key on the
keyboard. This is the fastest way of invoking a tool or a setting, and is almost
the only way to select the options of most tools. Therefore, this method is
recommended and is used in the subsequent modules. To help the students
familiarize with and memorize Command Line codes for tools and settings
used in the subsequent learning modules, a list of codes and key names is

provided as follows:

Name of Keyboard
Tools or Settings Shortcut
Open Ctrl+O
Cut Ctrl+X
Copy co

Copy and Paste
Line

Polyline pl
Polyline Edit pe
Multiline ml
Construction Line Xl
Polygon pol
Rectangle rec
Arc a
Ellipse el
Circle G
Multiline Text mt
Explode X
Erase e, or Delete key (on the keyboard)
Mirror mi
Offset 0
Array ar
Move m

Ctrl+C and Ctrl+V
|
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Name of Keyboard

Tools or Settings Shortcut

Rotate ro

Scale sc

Trim tr

Extend ex

Properties ch, mo, or double-click the entity
Measurement me (do not type measure)
Division div

Drafting Settings ds

Options op

Distance di

Layer Properties

Manager la

Achieving accuracy in drafting

Accuracy in drafting is very important in the solution of descriptive geometry
problems. In AutoCAD, such accuracy can be achieved by the following factors:
Correct Command Line data entry: generally speaking, after a tool (such as
Line and Circle) is invoked, the Command Line prompts the user to select
an option by typing the capitalized letter of the name of the option (Figure 1-
5L), or to type a requested value for a parameter (such as the center and radius
of the circle, or the endpoints of a line), and then and pressed the Enter key
on the keyboard to confirm the option and to proceed to the next option. The
entry of values can be:

1.

“Absolute coordinates:” Type the x,y,z values of a point in the three-
dimension space counted from the 0, 0, 0 origin point of the WCS, the
default World Coordinate System or the user-defined User Coordinate
System (UCS), with locations on the right, above and toward user from
the origin as positive values, and locations on the left, below and away
from the user from the origin as negative values, following the “right-hand
rule,” as shown in Figure 1-5M. For example, typing 3,5,-6 (no space
between the comma punctuation “,” and the next value) and press the
Enter key on the keyboard designates a point 3 units on the right, 5 units
above and 6 units away from the user, all counted from the 0,0,0 origin
point of the default World Coordinate System or the user-defined User
Coordinate System.
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Figure 1-5L: Entry of option or value in the finger pointing to +z).
Command Line. “Absolute coordinates” entry (1%
line); “relative coordinates” entry (2™ line); “polar
coordinates” entry (3" line).

2. “Relative coordinates:” Type the X, y, z values of the next point in the
three-dimension space counted from the previous point, in the format of
@x,y,z, following the same sign conventions as in “absolute
coordinates”). For example, typing @4,-1, 6 (no space between the
comma punctuation “,” and the next value) and press the Enter key on the
keyboard designates a point 4 units on the right, 1 units below and 6 units
toward the user, all counted from the last point entered.

3. “Polar coordinates:” Type the distance value, always positive, and the
angular value, in the format of @distance<angle-value, with any angle
formed CCW or counter-clockwise from the positive x-axis of the User
Coordinate System or UCS being a positive value, and any angle formed
CW or clockwise from the positive x-axis of the User Coordinate System
or UCS being a negative value. For example, typing @3<-30 and press the
Enter key on the keyboard designates a point with a 3 units distance and
30° counted CCW from the positive x-axis of the UCS, counted from the
last point entered.

e Correct usage of Object Snaps: The Object Snaps (OSNAP) allow the user to
accurately set the coordinate points at certain strategic points of an entity
(such as the Center and the four Quadrants of a Circle). There are two ways
to access the Object Snaps:
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1. *“Running Object Snaps:” Too many Object Snaps turned on will cause

confusion when picking up a needed Object Snap; therefore, turn on only
the most frequently used Object Snaps as “running Object Snaps” in the
Drafting Settings window, under the Object Snap tab. To open this
window, type ds in the Command Line and press the Enter key on the
keyboard; click the [ check box between the symbols and the names of
the Object Snaps (check marks are placed in the boxes as ), and on the
left of Object Snap On (F3) text to turn “running Object Snaps” on;
click the OK button to set the parameters and close the window (See

Figure 1-5N).
] Drafting Settings @g]
Snap and Grid | Polar Tracking | Obiect Snap | Dynamic Input
Object Snap On [F3) [] Object Snap Tracking On (F11]
Ohject Snap modes
Oa Endpaint 0 [ingertion Select Al
iy Midpaint b [ Perpendicular Clear A1l
] LCenter el Tangent
fits] Mode % [ Meamest
&) Dg B [ Apparent intersection
o Interzection 2 [ Paraliel
- [ Extension
) To track from an Osnap point, pause over the paint whils in a
\y command. A tracking wector appears when pou move the cursar.
To stop tracking, pause over the point again.
oo ) ]

Figure 1-5N: Turning running
Obiject Snaps on in the Drafting

Settings window.

2. “Temporary Object Snaps:” For Object Snaps that are not used

frequently, invoke them when needed by typing the first three letters of
their name during the creation of a geometry entity.

Osnap Code Osnap
Endpoint  end Intersection
Midpoint  mid Extension
Center cen Insertion
Node nod Perpendicular
Quadrant  qua Tangent

Code Osnhap

int Nearest

ext Apparent
Intersection

ins

per Parallel

tan

Code

nea

app

par
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Correct usage of ORTHO and POLAR functions: The ORTHO and POLAR

function allow “direct distance entry” (DDE) during the creation and editing
of a geometric entity. This method is very important in the solution of
descriptive geometry problems through orthographic projection to be covered
in the subsequent learning modules. Using this method, the users can move
the mouse cursor to a certain direction, type a number that represents a
distance along the constraint direction, and press the Enter key on the
keyboard to establish a point on the geometric entity to be created:

1. ORTHO: When the user click the ORTHO button beneath the

Command Line or press the F8 key on the keyboard (Figure 1-5P), the
ORTHO is turned on (the button looks “recessed”). When the user again
click the ORTHO button beneath the Command Line or press the F8 key
on the keyboard, the ORTHO is turned off (the button “jumps back to the
front”). The ORTHO allows the user to draw only straight lines along the
x- and y-axes according to the World Coordinates System or User
Coordinates System chosen with the UCS tool. Since multi-view
orthographic projection lines are drawn along these axes, the ORTHO
function plays an important role in the solution of multi-view drafting
problems. To use the ORTHO function as constraints for creating
orthographic projection lines, while using the Line tool, first invoke the
Line tool and press the F8 key to turn ORTHO on, then click-select a
point to be projected with the help of an appropriate Object Snap, then
drag the mouse cursor in the desired direction and click once at a
convenient location (Figure 1-5Q). To use the “direct distance entry”
(DDE) method during the creation of a geometric entity, after a tool (such
as Line) is invoked and the first endpoint is established, press the F8 key
to turn ORTHO on, drag the mouse cursor to the desired side of the first
point to (left, right, top, or bottom), type a number for the distance and
press the Enter key to finish (Figure 1-5R).

|
[ 47 » | M|\ Model {Layoutl fLayout2 f

AutoCAD Express Tools Copyright @ 2002-2004 Autodesk. Inc.

AutoCAD menu utilities loaded. _— .
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—— ORTHO and POLAR
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+s Start Command Line.

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



AutoCAD Module 1A: 1A-35

The Basic Concepts and Application of Descriptive Geometry

A:ig the cursor to the direction of
— /" auxiliary view and click at a

\ /. convenient location

Align the UCS (3 Point option)
i? ‘-/7\uth the angled edge

=

b o R B e
PR - aHO

Pick the point
with Endpoint
Object Snap

FERERFERBF
HKuNITTL

W4 b W Model (Lot [Lageni2 [ £

:u! LIKE Sp-uc:.ly“!i:l;;i poant =
pecify next point or
pecily next point or [Undo) ()il 'HO on

ommard LINE Specify first poant
pecily next point or [Undo)

SHAP GRID |DRTHO POLAR [OSNAP |OTRACK DN |LwT |[MODEL

Figure 1-5Q: Multi-view orthographic projection lines drawn along the x- and y- axes established by the
UCS, with the ORTHO constraint turned on.
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Figure 1-5R: “Direct Distance Entry” with
ORTHO turned on when using the Line tool.

.‘sta
2. POLAR (Polar Tacking): When the user click the POLAR button
beneath the Command Line (on the right of the ORTHO button) or
press the F10 key on the keyboard, the POLAR is turned on (the button
looks “recessed”), and the ORTHO is automatically turned off. When the
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user again click the POLAR button beneath the Command Line or press
the F10 key on the keyboard, the POLAR is turned off (the button “jumps
back to the front”). The POLAR allows the user to draw straight lines at a
suggested angle with the x-axes according to the Increment angle values
at in the Drafting Settings window under the Polar Tracking tab. To
setup Polar Tracking parameters, type ds in the Command Line and
press the Enter key on the keyboard to open the Drafting Settings
window, and select the Polar Tracking tab; in the Polar Angle Settings
section, click the downward arrow v button for a pull-down list of
available increment angles and select one (“increment angles” are
multiples of a selected angle; for example, if 30 is selected from the list,
then Polar Tracking will apply to 30°, 60°, 90°, 120°,...); to add a
particular angle needed, click the New button, a boxed text field appears in
the [ Additional angles white space, type a number for an additional
angle (Additional angles applies only to the particular angles established,
not to their multiples); then click the [J check box on the left of both
Polar Tracking On (F10) and Additional angles texts, check marks are
placed inside the boxes (M); click the OK button to set the parameters and
close the window (Figure 1-5S). To use the POLAR function as hints for
creating angled lines with the “direct distance entry” (DDE) method,
first invoke the Line tool and press the F10 key to turn POLAR on, then
select the first endpoint of the line, then move the mouse cursor in the
desired angular direction until a dotted “tracking line” and a boxed “polar
tracking tip” appear on the screen; then type a number representing the
distance along the angular direction from the first point, and press the
Enter key on the keyboard to finish (Figure 1-5T).

The ORTHO and POLAR functions are mutually exclusive since the
ORTHO constraints the direction parallel to the x-axes, while the POLAR
constraints the direction at an angle to the X- and y-axes; in other words, they
can not be turned on at the same time.
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Layer management in AutoCAD files

The last part of this module will explore the concept of layer in AutoCAD.
Layers in AutoCAD allow collective management of the properties (such as color, line
weight, line type, etc.) of objects created in particular layers; and if any of the properties
of a particular is changed in the Layer Properties Manager, then the relevant property
of all objects created in the layer (except the ones whose relevant property has been
individually changed before) will change accordingly. In a typical drawing, different
types of objects (for example, object lines, hidden lines, center lines, dimensions, etc.) are
created with different properties for convenient identification. In the subsequent learning
modules, it is recommended that students create different types of objects in different
layers, by first selecting the appropriate layer from the layer pull-down list (Figure 1-6A),
and then start to create object on the selected layer; all objects created on the selected
layer will assume the properties of the layer. By default, all objects create in any layer
have their properties listed as ByLayer in Color, Linetype and Lineweight pull-down
list. Occasionally, any of the properties of one or several objects created on a layer needs
to be changed; to accomplish this task, select the objects first, then go to the Color,
Linetype and Lineweight pull-down list and select the appropriate item (Figure 1-6B);
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when the task is accomplished, press the Esc key on the keyboard to exit the editing
process.

We will now proceed to creating several layers for the subsequent learning
modules. Click the Layer Properties Manager tool button on the Properties tool bar; the
Layer Properties Manager window opens (Figure 1-6C).

@ AutoCAD 2006 - NOT FOR RESALE - [C:\Docu:nents and Sett

E? Fil= Edit View Insert Format Tools Draw Pimension Modify |

DHEEH 2082 D06 74 € - «
== | ¥ Q@ O Hidden v £
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-4 Ke O M Dimension
DS | O% M HFP & Ref Planes
dlb ol (,_J "1l Hidden
& T YOS THE Viewport
| g . . .
= Figure 1-6A: Selecting the appropriate

= | )

= layer from the layer pull-down list.

On each layer in the Layer Properties Manager window, there are several
options that we can change by clicking the item listed on each layer to open the related
window, and choosing the appropriate item in the window and then clicking the OK
button. These options and related windows include:

e Select Color window: Click-select any color in the samples well and click the

OK button to return to the Layer Properties Manager window (See Figure
1-6C).

e Select Linetypes window: By default, this window lists only one line type
(continuous), as shown in Figure 1-6C. To add more line types, click the
Load... button; the Load or Reload Linetypes window opens (Figure 1-6D);
select a line type and click the OK button to return to the Select Linetypes
window, and click the OK button to return to the Layer Properties Manager
window.

e Lineweight window: Notice that all line weights are measured in metric unit
(millimeter or mm). Select appropriate line weight (Figure 1-6C) and click the
OK button to return to the Layer Properties Manager window. In the
drawing window, the line weight of the objects can be displayed when the
LWT button is turn on (Figure 1-6E).
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On button: A bright yellowish light bulb symbol is by default displayed under
the On option name, indicating that the objects to be created on the layer will
be visible; to make the objects invisible, click the bright yellowish light bulb
symbol; it turns to a grayish bulb, indicating that the objects to be created on
the layer will be invisible (Figure 1-6F).
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Figure 1-6C: Layer Properties Manager with various property options.

1A-41

e Plot button: A printer symbol is by default displayed under the Plot option
name, indicating that the objects to be created on the layer will be printed; to
make the objects not printable (but still visible on the layer unless the On
button is turned off), click the printer symbol; a red forward slash/is placed
on the printer symbol (in the previous version of AutoCAD, a red stop sign &
was used), indicating that the objects to be created on the layer will not be

printed (Figure 1-6F).
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To create a new layer, click the New Layer button (Figure 1-6F); a new layer
appears in the list with the name highlighted, type a new name and perform desired
changes of properties (Notice that the name of the first layer that is created by default will
stay 0 and cannot be changed). To delete a layer, select the layer first and then click the
Delete Layer button, with a red x symbol, as shown in Figure 1-6F (Notice that the first
layer that is created by default, or the layer 0, cannot be deleted). It is recommended to
create several layers with properties as shown in Figure 1-6G. Notice that the Layer 0
will be used to create visible (“object”) lines (especially the cut lines in development
patterns) throughout the subsequent learning modules. When all layers are created with
desired properties, click the OK button to exit the Layer Properties Manager window.
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(highlighted).

Figure 1-6J: Selecting AutoCAD Drawing Template
[*.dwt] file type.

Saving the file as an AutoCAD .dwt template file

We will now proceed to save the file as an AutoCAD .dwt Drawing Template file,
which allows the file to be used many times and saved as other AutoCAD .dwg Drawing
files. Go to the File->Save menu (Figure 1-6H) or press the Ctrl and s keys on the
keyboard simultaneously, to open the Save Drawing As window.

In the Save Drawing As window, select AutoCAD Drawing Template [*.dwt]
file type from the Files of type pull-down list (Figure 1-6J); the AutoCAD Save file
directory jumps to the Template folder (Figure 1-6K); go to the Save in pull-down menu
to select a desired directory, in this case, we choose the Desktop (Figure 1-6L); click the
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Create New Folder icon to create a new folder (Figure 1-6M); a new folder opens with
the default name highlighted (Figure 1-6N).
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Figure 1-6M: Clicking
the Create New Folder
icon to create a new
folder.

Figure 1-6N: The new
folder with the default
name highlighted.

Next, type AutoCAD Descriptive Geometry Learning as the name for the folder
and double-click the icon of the folder to open it (Figure 1-6P); in the File name text
field, type AutoCAD Descriptive Geometry Template as the name for the file and click
the Save button to save the file as a template (Figure 1-6Q); the Template Description
window opens; type a description text if desired and click the OK button to save the file
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(Figure 1-6R). The template’s icon appears in the folder just created, on the Desktop
(Figure 1-6S).
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open it.

Figure 1-6Q: Typing a
new name for the file
and clicking the Save
button to save the file
as a template.
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AutoCAD Module 1A: 1A-48

The Basic Concepts and Application of Descriptive Geometry

For your convenience, when you start a new module during this course, you can
first launch the AutoCAD program; then open the AutoCAD Descriptive Geometry
Template file from the AutoCAD Descriptive Geometry Learning folder; and then go to
the File>Save As... menu (Figure 1-6T) to save is under another name and as an
AutoCAD 2004 Drawing [*.dwg] file (this file format can be accessed from the Files of
type: pull-down list, as shown in Figure 1-6Q), in the same folder; and then start your
drafting session.

Congratulations! In this module, you have explored
e The basic concepts and terms of descriptive geometry; and

e The application of the knowledge of and skills in solving descriptive geometry
problems in industry, especially the sheet-metal design and fabrication;

In addition, you have

e Reviewed the basic tools and settings of AutoCAD programs that will be use
in the subsequent learning modules; and

e Saved an AutoCAD .dwt Drawing Template file with useful layers for future
use in the subsequent learning modules.
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